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Chapter 467

Tests for the Ratio of
Two Within-Subject
Variances in a
Parallel Design
Introduction
This procedure calculates power and sample size of inequality tests of within-subject variabilities from a two-group,
parallel design with replicates (repeated measurements). This routine deals with the case in which the statistical
hypotheses are expressed in terms of the ratio of the within-subject variances.

Technical Details
This procedure uses the formulation given in Chow, Shao, Wang, and Lokhnygina (2018), pages 192-193.
Suppose 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖 is the response of the ith treatment (i = 1,2), jth subject (j = 1, …, Ni), and kth replicate (k = 1, …, M).
The model analyzed in this procedure is
𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖 = 𝜇𝜇𝑖𝑖 + 𝑆𝑆𝑖𝑖𝑖𝑖 + 𝑒𝑒𝑖𝑖𝑖𝑖𝑖𝑖

where 𝜇𝜇𝑖𝑖 is the treatment effect, 𝑆𝑆𝑖𝑖𝑖𝑖 is the random effect of the jth subject in the ith treatment, and 𝑒𝑒𝑖𝑖𝑖𝑖𝑖𝑖 is the within2
. Unbiased estimates of these
subject error term which is normally distributed with mean 0 and variance 𝑉𝑉𝑖𝑖 = 𝜎𝜎𝑊𝑊𝑊𝑊
variances are given by
𝑁𝑁𝑖𝑖

𝑀𝑀

1
2
� ��𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖 − 𝑥𝑥̅𝑖𝑖𝑖𝑖 . �
𝑉𝑉�𝑖𝑖 =
𝑁𝑁𝑖𝑖 (𝑀𝑀 − 1)
𝑗𝑗=1 𝑘𝑘=1

A common test statistic to compare variabilities in the two groups is 𝑇𝑇 = 𝑉𝑉�1 /𝑉𝑉�2. Under the usual normality
assumptions, T is distributed as an F distribution with degrees of freedom 𝑁𝑁1 (𝑀𝑀 − 1) and 𝑁𝑁2 (𝑀𝑀 − 1).
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Testing Inequality
The following hypotheses are usually used to test for inequality
𝐻𝐻0 :

2
2
𝜎𝜎𝑊𝑊1
𝜎𝜎𝑊𝑊1
=
1
versus
𝐻𝐻
:
𝐴𝐴
2
2 ≠ 1.
𝜎𝜎𝑊𝑊2
𝜎𝜎𝑊𝑊2

The corresponding test statistics are 𝑇𝑇 = (𝑉𝑉�1 /𝑉𝑉�2 ).

Power

The power of this combination of tests is given by
Power = P�𝑅𝑅1�𝐹𝐹𝛼𝛼/2,𝑁𝑁1 (𝑀𝑀−1),𝑁𝑁2 (𝑀𝑀−1) � � + 1 − P�𝐹𝐹 < 𝑅𝑅1�𝐹𝐹1−𝛼𝛼/2,𝑁𝑁1 (𝑀𝑀−1),𝑁𝑁2 (𝑀𝑀−1) � �

where F is the common F distribution with the indicated degrees of freedom, 𝛼𝛼 is the significance level, and R1 is
the value of the actual variance ratio. Lower quantiles of F are used in the equation.
A simple binary search algorithm can be applied to this power function to obtain an estimate of the necessary
sample size.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and
power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power or Sample Size.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal variances when in fact the variances are unequal.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
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Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal
variances when in fact the variances are equal.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
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For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
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N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.
M (Measurements Per Subject)
Enter one or more values for M: the number of repeated measurements made on each subject.
You can enter a single value such as 2, a series of values such as 2 3 4, or 2 to 8 by 1.
The range is M ≥ 2.

Effect Size
R1 (Actual Variance Ratio)
Enter one or more values for within-subject variance ratio assumed by the alternative hypothesis. This is the value
2
2
/𝜎𝜎𝑊𝑊2
at which the power is calculated.
of 𝜎𝜎𝑊𝑊1
This value should be greater than zero. It cannot be equal to one.
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Example 1 – Finding Sample Size
A company has developed a generic drug for treating rheumatism and wants to show that it is has a different
within-subject variance from the standard drug. A parallel-group design with replicates will be used.
Company researchers set the significance level to 0.05, the power to 0.90, M to 2 or 3, and the alternative variance
ratio values between 0.5 and 2.0. They want to investigate the range of required sample size values assuming that
the two group sample sizes are equal.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for the Ratio of Two Intra-Subject Variances in a Parallel Design procedure window.
You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
M (Measurements Per Subject) .............. 2 3
R1 (Actual Variance Ratio) ..................... 0.5 0.66667 0.8 1.25 1.5 2

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────

Actual
Power
0.9017
0.9049
0.9004
0.9015
0.9003
0.9003
0.9003
0.9003
0.9004
0.9015
0.9017
0.9049

Group 1
Sample
Size
N1
89
45
257
129
846
423
846
423
257
129
89
45

Group 2
Sample
Size
N2
89
45
257
129
846
423
846
423
257
129
89
45

N
178
90
514
258
1692
846
1692
846
514
258
178
90

Measures
Per
Subject
M
2
3
2
3
2
3
2
3
2
3
2
3

Actual
Variance
Ratio
R1
0.500
0.500
0.667
0.667
0.800
0.800
1.250
1.250
1.500
1.500
2.000
2.000

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050

References
Chow, S.C., Shao, J., Wang, H., and Lokhnygina, Y. 2018. Sample Size Calculations in Clinical Research, Third
Edition. Taylor & Francis/CRC. Boca Raton, Florida.
Chow, S.C. and Liu, J.P. 2014. Design and Analysis of Clinical Trials, Third Edition. John Wiley & Sons.
Hoboken, New Jersey.
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Report Definitions
Actual Power is the actual power achieved. Because N1 and N2 are discrete, this value is usually slightly
larger than the target power.
N1 is the number of subjects from group 1. Each subject is measured M times.
N2 is the number of subjects from group 2. Each subject is measured M times.
N is the total number of subjects. N = N1 + N2.
M is the number of times each subject is measured.
R1 is the value of the within-subject variance ratio at which the power is calculated.
Alpha is the probability of rejecting a true null hypothesis, H0.
Summary Statements ─────────────────────────────────────────────────────────
A study is being conducted to assess the inequality of within-subject variability of two groups
by looking at the ratio of their variances. If the sample variance ratio is too large or too
small, the group variabilities are concluded to be unequal. Group sample sizes of 89 and 89
achieve 90% power to reject the null hypothesis of equality at a significance level of 0.050.
The variance ratio at which the power is calculated is assumed to be 0.500. Each subject is
measured 2 times.

This report gives the sample sizes for the indicated scenarios.

Plot Section

These plots show the relationship between sample size, R1, and M.
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Example 2 – Validation using Hand Calculations
We could not find an example in the literature, so we will present hand calculations to validate this procedure.
Set N1 to 257, the significance level to 0.05, M to 2, and the actual variance ratio value 0.66667. Compute the
power.
The calculations proceed as follows.
Power = P�𝑅𝑅1�𝐹𝐹𝛼𝛼/2,𝑁𝑁1 (𝑀𝑀−1),𝑁𝑁2 (𝑀𝑀−1) � � + 1 − P�𝐹𝐹 < 𝑅𝑅1�𝐹𝐹1−𝛼𝛼/2,𝑁𝑁1 (𝑀𝑀−1),𝑁𝑁2 (𝑀𝑀−1) � �
= P�𝐹𝐹 < 0.66667𝐹𝐹0.025,257,257 � + 1 − P�0.66667𝐹𝐹0.975,257,257 �

= P(𝐹𝐹 < 0.66667(0.78265629) ) + 1 − P(𝐹𝐹 < 0.66667(1.27770007) )

= P(𝐹𝐹 < 0.52177347 ) + 1 − P(𝐹𝐹 < 0.85180431 )

= 0.00000012 + 1 − 0.099613912

= 0.9003862

Hence, the power is 0.9004 to four decimal places.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for the Ratio of Two Within-Subject Variances in a Parallel Design procedure
window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File
menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 257
M (Measurements Per Subject) .............. 2
RA (Alternative Variance Ratio) .............. 0.66667

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Group 1
Sample
Size
Power
N1
0.9004
257

Group 2
Sample
Size
N2
257

Measures
Per
Subject
N
M
514
2

Actual
Variance
Ratio
R1
0.667

Alpha
0.050

The power matches the hand-calculated result.
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